POLKADOTS SOFTWARE
Installing PrePage-it Client 5.1
PrePage-it Client Installation Guide

Table of Contents
OVERVIEW ................................................................................................................................................................................3
UPGRADING FROM A PREVIOUS VERSION ...................................................................................................................................3
Disabling the 4D Server: JobMan service.............................................................................................................................3
INSTALLING PREPAGE-IT CLIENT ENGINE 5.1............................................................................................................6
Polkadots dongle and key......................................................................................................................................................6
Updating the dongle .............................................................................................................................................................................................................. 6

4D License.............................................................................................................................................................................7
NFR vs. STD ......................................................................................................................................................................................................................... 8

Before installing ....................................................................................................................................................................8
QuickTime Player ................................................................................................................................................................................................................. 8
Add a Windows printer ......................................................................................................................................................................................................... 9
Install dongle and key ........................................................................................................................................................................................................... 9

Client Engine installation procedure ....................................................................................................................................9
Configuring the PrePage-it Client Service.......................................................................................................................................................................... 13
Installing updates................................................................................................................................................................................................................. 16

INSTALLING PREPAGE-IT CLIENT 5.1 FOR MAC OS X.............................................................................................19
INSTALLING PREPAGE-IT CLIENT 5.1 FOR PC...........................................................................................................23
CONFIGURING THE DRIVES LIST...................................................................................................................................28
Displaying the Drives list ....................................................................................................................................................28
Setting up the Drives list .....................................................................................................................................................30
Guidelines for Drives List ...................................................................................................................................................32

PREPAGE-IT

CLIENT

5.1

INSTALLATION

GUIDE

Overview
This document explains how to install PrePage-it Client Engine 5.1 (formerly called Manage-it Server) on
a Windows XP/2000/2003 system and PrePage-it Client 5.1 (formerly called Manage-it Client) on a Mac OS X
or PC. Please note that the PrePage-it Client 5.1 does not run on Mac OS 9.

Upgrading from a previous version
If you currently have a previous installation of Manage-it Server (i.e. v.3.5 or 5.0) on the machine
where you will be installing v.5.1, you cannot do a direct installation upgrade from v.3.5/5.0 to a
v.5.1. PrePage-it Client Engine 5.1 must be installed from scratch.
If you will no longer be using the previous installation of Manage-it Server, you can either
uninstall it or disable the Service so that it is not using up resources on the server machine. To
uninstall Manage-it Server 5.0, run the Installer that you used to install Manage-it. During the
installation procedure, you will be prompted with the following dialog box.

Figure 1 – Uninstalling Manage-it 5.0

Selecting Delete All and then Continue will uninstall the software.
Manage-it 3.5 Server does not have an integrated uninstaller. The simplest option is to disable the
4D Server: JobMan service, as explained in the next section. If you must uninstall Manage-it 3.5,
please contact a Polkadots support specialist to obtain an uninstaller program.
Disabling the 4D Server: JobMan service

1. On

the

Windows

server,

open

the
Start > Programs > Administrative Tools > Services.
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Stop

Figure 2 – Services window

2. Select the 4D Server: JobMan service, click the Stop button to stop the service, then click the
Properties button to display the Properties window.

Select Disabled

Figure 3 – Disable 4D Service

3. Select Disabled from the Startup type dropdown list, then click Apply. The 4D Server: JobMan
service should now be Disabled.
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Installing PrePage-it Client Engine 5.1

The installer for the PrePage-it Client Engine (formerly Manage-it Server) has been simplified
compared to previous versions. Previously there were separate installers for NFR vs. Standard
versions as well as for initial installations vs. updates. There is now a single installer for PrePage-it
Client Engine 5.1 which handles the various installation scenarios mentioned above, either by
automatic detection or through user interaction.
Most of the installation procedure is the same as for previous versions. The next few sections
review the basics of the server installation. Later sections describe the details about the
installation procedure.
Polkadots dongle and key

Each computer running Polkadots Software products requires a Polkadots dongle that has been
activated with an appropriate license key. Even if more than one software application is installed
on the same computer (e.g. PrePage-it Viewer, PrePage-it Client), only a single dongle and license key
are necessary.
A USB dongle is normally supplied with your software, however Parallel dongles are available on
request. There is no difference between them except for the port that they can be plugged into.
The dongle must be plugged into an appropriate port on your Windows machine before
installing PrePage-it Client and must remain plugged in at all times while working with PrePage-it
Client.
The license key must include permission to operate the PrePage-it Client. If it doesn’t, you must
request an updated key from your dealer. Usually, however, when there are changes with any of
your Polkadots Software products (e.g., purchasing a new product, adding options to your current
software), then you will automatically be given an updated key.
In order for your new or updated software to work, you must update the dongle by activating the
key that your dealer sent you. Since there is only one dongle and key for all your Polkadots
products, when you update the dongle, the license for all your Polkadots products (including the
PrePage-it Client) are updated at the same time.
Updating the dongle

The key is a file with a .upd extension, usually sent to a customer by e-mail or ftp. A sample name
for a key file would be 1739-251204.upd or 1739-unlimited.upd, where 1739 is your Polkadots dongle
number. A date in the dongle key file indicates a temporary license which will expire at a given
6
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date whereas “unlimited” refers to a permanent key with no expiration date. Although the actual
filename may vary, it will always have a .upd extension.

Polkadots
License key
files

Figure 5 – Polkadots license key files

To update the dongle with the updated key that you’ve received, simply double-click on the key
file. After a few seconds, a pop-up message will confirm the update with “Your key is now updated”,
indicating that the dongle has been updated.

Figure 6 – Dongle key updated

Tip

The dongle update takes effect immediately. If you have already installed the software
and the dongle update has not taken effect, restart the PrePage-it Client service.
4D License
Reminder

The NFR version does not require a 4D license.
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In addition to the Polkadots dongle and license key, which is good for all Polkadots software,
PrePage-it Client 5.1 also requires a 4D license, which consists of one or more license files. These
license files are supplied by your dealer when you purchase a STD version of PrePage-it Client.
How many license files you receive depends on the number of Clients you purchase and other
factors. Installation of an NFR version of the PrePage-it Client does not require a 4D license.
More information about the difference between the STD (Standard) and NFR (Not For Resale)
version of the PrePage-it Client can be found in the next section, NFR vs. STD.
Note that a single license file may represent one, two or more PrePage-it Clients – you will not
necessarily be supplied with a different file for each client application in your workflow.
You will be prompted to select your license files during installation. If you add more Clients at a
later time, you will be supplied with additional license files. You will then need to perform a
software update whereby you will provide your new license file.
NFR vs. STD

NFR (Not For Resale) versions of the PrePage-it Client are for demonstration purposes only. If
you do not enter any 4D license files during the initial installation, the NFR version of the
PrePage-it Client will be installed.
STD (Standard) versions of the PrePage-it Client are installed for customers who have purchased
the software. If you provide a valid 4D license file during the initial installation, the STD version
of the PrePage-it Client will be installed. Upon purchase of the software, you will be supplied
with one or more license files, which must all be entered during the installation procedure. See
Client Engine installation procedure on p.9 for details.
If you need to go from an NFR to a STD version, you must run the Installer and provide a valid
4D license file. See Installing updates on p. 16 for details.
Before installing

Before installing PrePage-it Client, you must:
• install QuickTime Player
• add a Windows printer (if none exists)
• plug in the Polkadots dongle and activate the Polkadots license key
QuickTime Player

In order for PrePage-it Client to work properly, you must install Apple’s QuickTime Player on
your machine before you install PrePage-it Client. You can download this software free of charge
from the Apple website, at http://www.apple.com/quicktime/.
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Warning

An incompatibility has been identified between a Windows update (for Windows
XP/2003) and QuickTime 7.1. When Windows Update KB908531 and QuickTime 7.1 are
both installed on the same machine as the 4D Server, it may prevent the 4D Server
from launching. This problem can be prevented by not installing or upgrading to
QuickTime 7.1, but rather using a previous version e.g. QuickTime 7.04.
Add a Windows printer

At least one Windows printer must be installed on your machine in order for PrePage-it Client
Engine to start up after installation.
Windows printers can be added with the Add Printer Wizard, which can be accessed from the
Windows Start menu or Control Panel (click Printers > Add Printer). Refer to your Windows
documentation for more details on installing a printer.
Install dongle and key

Make sure the dongle is plugged into an appropriate port (typically USB). If you received an
updated license key, activate the license key, as described in the section Updating the dongle on
page 6.
Client Engine installation procedure
Warning!

When the PrePage-it Client Engine is installed on a Windows XP or 2003 machine,
certain Windows default settings may prevent the Client Engine from functioning
properly. This applies to settings such as DEP (Data Execution Prevention) and Windows
Firewall. Please refer to the tech note Installation issues with Win XP-SP2 & 2003-SP1
(available from your Polkadots dealer) for full details regarding how to configure your
Windows system.
To install the PrePage-it Client Engine:
1. Double-click the installer, typically called PPIT Client Engine.exe (note that the build date is
usually included in the name – see figure below).

Figure 7 – Client Engine installer
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2. Select a language if prompted. Then click Next at the Welcome screen. In the License
Agreement window, click the checkbox I accept the terms in the License Agreement if you
accept them, and click Next.

Figure 8 – License Agreement

3. If you are installing a STD version of the Client Engine, specify the location of your 4D
license file and click Add. Repeat this step until you’ve selected all your 4D licenses, then
click Next to complete the procedure. If you are installing an NFR version or have not yet
received the 4D licenses, just click Next.
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Figure 9 – Add 4D license

Note

If you are installing a STD version but have not yet received the 4D licenses, you may
run the installer at a later time to add the licenses. See Installing updates on p. 16 for
details.
4. The following window will then be displayed. Specify where the Client Engine should be
installed by either accepting the default directory or choosing a different location, then
click Next.
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Figure 10 – Select installation directory

5. Select Local Account. Then type the Username and Password of a user account with
Administrator rights, and click Install.

Figure 11 – Specify Administrator user
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6. When you see the Completing Setup window, click Finish.

Figure 12 –Finish Installation

Configuring the PrePage-it Client Service

When PrePage-it Client Engine is installed, a service called 4D Server: PrePage-it Client is created on
the Windows Server. On newer installers, this service is configured during the installation
procedure and then automatically started. If you’re using an older PrePage-it Client Engine
installer, however, you will need to manually set the service to log on with the Administrator account
and then it must be started.
Also, the service may occasionally need to be stopped and then restarted for maintenance
purposes, such as when you install an updated build or if you need to reconfigure the service.
These procedures are described below.
STOPPING / STARTING THE SERVICE

To stop or start the PrePage-it Client service, open the Services window by clicking
Administrative Tools > Services, accessed from the Windows Start menu.
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Start service

Stop service
The PrePage-it Client
service is called
4D Server:PrePage-it Client

Restart service

Figure 13 – Services window

In the Services window, locate and right-click on the 4D Server: PrePage-it Client service. Then,
depending on what you want to do, choose either Start, Stop or Restart from the contextual
menu.
LOGGING THE SERVICE AS THE ADMINISTRATOR USER

1. Click on Administrative Tools > Services. This will display the Services window.

Figure 14 – Locate 4D Server : PrePage-it Client
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2. In the Services window, locate and right-click on the 4D Server: PrePage-it Client service, then
choose Properties. The Properties window will be displayed, as shown in the figure below.

Figure 15 –Service Properties

3. Next, click on the Log On tab and set up the service to log on as Administrator:
• select This account
• enter an account name and password of a user with administrator rights, then click
OK
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Figure 16 – Configure ‘Log On’ properties

4. Finally, for the service to take effect, you must restart it by right-clicking on
4D Server : PrePage-it Client and choosing Start or Restart.
Installing updates

After the initial installation of PrePage-it Client, the installer can be used to add 4D licenses,
either because you had not yet received your licenses or because you have purchased additional
licenses. The installer may also be used to update to a new build of the PrePage-it Client Engine,
if recommended by your Polkadots dealer.
ADDING A 4D LICENSE

To add a 4D license:
1. Stop the 4D Server: PrePage-it Client service (see Stopping / starting the service on p. 13).
2. Run the installer (the same one used for your initial installation).
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Figure 17 – Client Engine installer/updater

3. Click Next at the Welcome screen. Then click the checkbox I accept the terms in the License
Agreement if you accept them, and click Next.

Figure 18 – License Agreement

4. Specify the location of your 4D license file and click Add. Repeat this step until you’ve
selected all your 4D licenses, then click Next to complete the procedure. If you are just
updating your build version and do not need to add any 4D licenses, simply click Next.
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Figure 19 – Add 4D licenses

UPDATING YOUR BUILD

In order to update your PrePage-it Client Engine build, you need to receive a new installer. The
procedure for updating the build version is the same as for adding 4D license, except that you
skip the step about adding licenses. Simply run the new installer and follow the procedure
outlined in the section Adding a 4D license, starting on p.16.
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Installing PrePage-it Client 5.1 for Mac OS X

1. Unzip and run the Mac OS X installer.

Figure 20 –Mac OS X Installer

2. Click Continue at the Welcome window and also in the Software License Agreement window,
then click I Agree (when prompted) if you agree with the License Agreement.

Figure 21 – License Agreement

3. Select the Destination (i.e. installation) folder and click Continue.
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Figure 22 –Select Destination folder

4. Click Install.

Figure 23 –Begin installation

5. After the installer is finished, the window will display a message
successfully installed”. Click the Close button.
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6. Locate the PrePage-it Client 5.1.4 application and launch it. You will get the following
message “Error #-10002. The database cannot be used.” Click OK.

Figure 24 –Error message

7. The Connect to 4th Dimension 2004 window will be displayed (see figure below). Click on the
Custom tab, then type the Database Name PrePage-it.4DC and the Network Address
xxx.xxx.xxx.xxx,19051 (where xxx.xxx.xxx.xxx is the IP address of your Server i.e. the
machine where the PrePage-it Client Engine is installed). For example, if the server’s IP
address is 123.456.789.123, then type 123.456.789.123,19051 in the Network Address box.
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Figure 25 –IP address - Mac

8. After clicking OK, the PrePage-it Client will be launched.
The procedure just described should only be done during the initial installation. Afterwards, the
Client can be launched simply by starting the application in the usual manner.
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Installing PrePage-it Client 5.1 for PC

1. Run the PrePage-it Client installer for PC.

Figure 26 –PC Installer

2. Click Next at the Welcome window, then click Yes in the Software License Agreement window
if you agree with the License Agreement.

Figure 27 – License Agreement

3. Select the Destination (i.e. installation) folder and click Next.
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Figure 28 –Select Destination folder

4. Click Next at the Ready To Install window.

Figure 29 –Begin installation

5. If the installer displays a warning such as the one shown below, read it carefully to ensure
you comply with the warning. If yes, then click OK. Otherwise click Cancel, make the
necessary changes and re-run the installer.
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Figure 30 –Installation warning

6. When you are prompted for the IP address of your server, type the IP address of the
machine where the PrePage-it Client Engine is installed (for e.g. 192.121.122.123), then
click OK.

Figure 31 –IP address – PC

Note

If you do not know the IP address, you may leave it blank and click OK. You will
then have to provide the IP address when you first launch the PC Client.
7. After the installer is finished, the Finished window will be displayed. Click the Close button.
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Figure 32 –Installation complete

The installation is now complete, unless you did not provide the IP address of your server. In
this case, you will be prompted to provide it when you launch the PC Client for the first time, as
described next.
8. If you did not provide the IP address of your server during the installation, you will get the
following message when you first launch the PC Client: “Error #-10002. The database cannot
be used.” Click OK.

Figure 33 –Error message

9. The Connect to 4th Dimension 2004 window will be displayed (see figure below). Click on the
Custom tab, then type the Database Name PrePage-it.4DC and the Network Address
xxx.xxx.xxx.xxx,19051 (where xxx.xxx.xxx.xxx is the IP address of your Server i.e. the
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machine where the PrePage-it Client Engine is installed). For example, if the server’s IP
address is 123.456.789.123, then type 123.456.789.123,19051 in the Network Address box.

Figure 34 –IP address - PC

10. After clicking OK, the PrePage-it Client will be launched.
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Configuring the Drives List

In order for PrePage-it Mac Clients to access all the required workflow files, you need to add to
the Drives List all the volumes that you’ve mounted on the Mac Client’s desktop, which point to
the required files on the server machine. In some cases, you must add to the Drives List the
network drives that have been mapped on a PC Client workstation. Typically this includes the
volumes/drives containing the RIPped single-pages (also referred to as Final Pages) and the hot
folders.
The configuration of the Drives List has changed since the release of PrePage-it 5.x. In a
workflow with a previous version of PrePage-it (i.e. 4.6 or lower), the Drives List was populated
automatically on Mac Clients. In a workflow which includes PrePage-it 5.x, the Drives List must
now be configured manually both on Macs and PCs.
Displaying the Drives list

To display the PrePage-it Client’s Drives list:
1. Close the Jobs window by clicking the Close box in the upper left-hand corner. The
resulting window will look as shown in the figure below.
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2. Click File > Drive.

Figure 36 – Display the Drives list

3. The Drives list window will be displayed.
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Figure 37 –Drives list window

4. To bring the PrePage-it Client out of close box mode and back into regular mode, click
Jobs > All Jobs or press Command+J (Mac) or Control+J (PC).

Figure 38 – All Jobs command

Setting up the Drives list

Once a volume is added to the Drives List of one Client, it will be visible from all other Clients.
The Drives List can be configured from any Client in the following way:
1. Display the Drives List window (to know how, see Displaying the Drives list on p. 28).
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Figure 39 – Drives List - empty

2. Click the “+” button. Depending on whether you’re configuring a Mac or PC Client,
either enter the path of the shared volume manually or select a shared volume from a
dialog box.
3. Enter the share name. For Mac Clients, be sure to enter the exact name of the volume
that is mounted on the Mac’s desktop.
4. If you are prompted with a confirmation window, click the OK or Checkmark button.
5. The volume should now appear in the Drives List.

Figure 40 – Drives List - entry
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Guidelines for Drives List

Listed below are some guidelines for setting up appropriate entries for the Drives List:
• PCs where a PrePage-it Client is installed must have the Server Share (i.e. the drive where
the Final_Pages and Hotfolders reside) mapped with the same drive letter as on the
Server. When the Share is created on the Windows Server, it must be done at the root of
the drive (e.g. P:\ ), not a folder or sub-folder within that drive.
• If a workflow contains Mac Clients, entries to the Drives List only need to be made in the
Mac Clients – it is not necessary to make Drive List entries in the PC Clients. If a
workflow contains only PC Clients, then entries to the Drives List are required to be made
from the PC Clients.
• If a workflow has only one PrePage-it Client and it is located on the PrePage-it Windows
Server, it is still necessary to make the required entries to the Drives List from that PC
Client.
• A simple, effective way to set up a workflow with both Mac and PC Clients is: (i) create
both a Windows and Mac Share at the root of the drive where the Final_Pages and
Hotfolders reside (e.g. P:\ ), (ii) on each PC Client, map the Windows Share with the same
drive letter as on the Server, (iii) on each Mac Client, mount the Mac Share, (iv) add the
Macintosh-mounted volumes to the Drives List and (v) for the Mac Share name, make
sure to enter the exact name of the mounted volume.
• Do not set up entries in the Drives List such that one entry is the parent folder (or
enclosing folder) of another, as this may cause problems. For example, let’s say the Drives
List contains the following entries:


D:\PrePage-it\Final Pages



D:\PrePage-it\Hot Folders

These entries both have the same parent folder,
cannot be included in the Drives list.

D:\PrePage-it.

Therefore,

D:\PrePage-it

• It is recommended to create Server Shares at the root of the drive (e.g. P:\ ). In fact, this is
obligatory when PC Clients are involved. With Mac Clients, however, it does not matter
where on the Windows Server the Share is created. The Share can be done at any point
that contains the Final_Pages or Hotfolders – it does not have to be the root of the drive.
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